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In this booklet you will find everything you need to know
to get you up and running with Quicken 2011, whether you
are a new or existing user. We strongly recommend that you
read this booklet carefully and follow the steps outlined to
ensure your installation process is as smooth as possible.

If you have anti-virus software installed on your PC, it is
recommended that you disconnect your Internet connection
and then disable your anti-virus software, as it may interfere
with software installation.

If you are upgrading from an earlier version of Quicken, pay
special attention to the notes describing features that have
been changed or added to Quicken since your last upgrade.
You may need to perform additional steps in the upgrade
process, depending on how old your current version is. The
headings in each section provide a guide to finding the
instructions relevant to you.
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System Requirements

To install and use Quicken 2011 you need:

IBM® or compatible Pentium?® I 300 (Pentium Il 450
recommended) with 512 MB RAM

Microsoft® Windows® XP/Vista/7* operating systems
Compatible with Microsoft® Office XP/2003/2007
185 MB of disk space for Quicken installation, plus 55

MB for Microsoft Internet Explorer if IE 6.0 (provided on
installation CD).

Please note HUBB Investor software requires 5GB disk
space. (See www.hubbinvestor.com for more details)

Microsoft Internet Explorer® 6.0 or higher

800 x 600 resolution (SVGA 1024 x 768 with 16-bit
colour recommended)

Any printer supported by Windows® XP/Vista/7*
operating systems

Double speed CD-ROM (6x or higher recommended)

56 Kbps modem (high speed Internet access
recommended). Internet access is required for all
online features and services, such as online investment
tracking (HUBB Investor software requires cable, ADSL
or broadband internet access, see www.hubbinvestor.
com for more details )

*Windows 64 bit support for Window 7 only.

Reckon recommends you install the latest service packs for Microsoft®
Windows and Internet Explorer.
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Changes for 2011

Quicken includes many changes and new features in this
release. An overview of changes and features you should
note is provided below.

Your Installed Quicken Products

In most cases, Quicken 2011 will uninstall any Quicken
product previously installed on your PC. The data files
will remain in the same location they were in before the
installation of Quicken 2011.

To ensure a smooth upgrade process, we recommend

that you uninstall all previous versions of Quicken before
installing Quicken 2011. It is important you make a backup
of your Quicken files before doing so.

Changes to Cash Flow Forecasts

After upgrading, Quicken may not be able to recognise cash
flow scenarios that you have saved in a previous version. If
this occurs, you will need to re-create the forecast after the
upgrade.

To re-create the forecast after the upgrade:
1. Choose Planning menu > Cash Flow Forecast.

2. Choose Options > Select Accounts to customise the
accounts for the scenario. Click OK.

3. Choose Options > Manage Scenarios.

4. Click New and enter a Scenario Name, then click OK to
save the new scenario.

Updating your stocks from Quicken Version
8 or earlier

Quicken includes new features for tracking your
investments, such as the ability to download stock prices
from different exchanges (Australia, NZ, US). If you have
upgraded from Version 8, the exchange and asset class for
each security will be set to your default country. You must



specify the asset class and exchange for each security after
you have upgraded to Quicken 2011.

To specify the asset class and exchange for a security:
1. Choose Investing menu > Security List.

2. Highlight the individual security and then click Edit.
You can assign an exchange and asset class from the
relevant drop-down lists. If a‘'Symbol Change Affects
Price History’ message appears, click OK to copy the
quotes.

Term Deposit

Term deposits are fixed-term bank investments, paying a
fixed rate of interest over the term of the deposit. In Quicken
2011 Personal Plus and Home & Business, you can now

set up “Term Deposit” accounts to track your real-world
investments.

To set up a Term Deposit account:
1. Choose Investing menu > Go to Investing Centre.

2. Click Today’s Data in the right-hand corner of the
screen.

3. Inthe Investment & Retirement Accounts snapshot,
click Add Account.

4. Select Term Deposit then click Next.
5. Follow the on-screen instructions.

6.  When Quicken prompts you to set up a Term Deposit
security, click Yes.

7. Select Add new Security and click OK.

8. Set the “Security Type “to Term Deposit and give it a
unique name then follow the on-screen instructions.

9. Quicken will alert you on the day that your term deposit
matures. You can record your interest by selecting the
Term Deposit account, then click Enter Transactions.
Record your interest by choosing Record Income Event
or Miscellaneous Income.



Quicken New Zealand - KiwiSaver

If you are a Quicken New Zealand Personal Plus or Home &
Business user, you can now set up a KiwiSaver account in
Quicken 2011, which is a savings initiative to help set you up
for your retirement. You will build up your savings through
regular contributions from your pay through the KiwiSaver
wizard. A list of KiwiSaver providers is now available in
Quicken.

To set up a KiwiSaver account:
1. Choose Investing menu > Go to Investing Centre.

2. Click Today’s Data in the right-hand corner of the
screen.

3. Inthe Investment & Retirement Accounts snapshot,
click Add Account.

4. Select KiwiSaver then click Next.
5. Follow the on-screen instructions.

6. You can set up a paycheque for regular contributions
when Quicken prompts you to do so.

Data ConverterA

Microsoft has discontinued their personal finance product
- Microsoft® Money on the 30" of June 2009. If you were

a Microsoft® Money user, the Data Converter allows you
to transfer your Microsoft® Money transactional data to
Quicken.

You can choose to install Data Converter while you install
Quicken 2011. Alternatively, browse your CD and navigate
to d 2 \HAB\D I SK1\mny2qdT folder (where d: is your CD-
ROM drive) then run setup.exe to intall.

AYou can use the Data Converter tool to transfer your transactions to
Quicken 2011 from Microsoft Money® 2008; however Microsoft Money® and
Quicken operate using different accounting methods. Due to this limitation,
the Data Converter attempts to achieve the best outcome during the
conversion process.

It is highly recommended that you read the Quicken Data Converter
document (browse your CD and navigate to d - \HAB\D I SK1\mny2qdf



folder where d: is your CD-ROM then open 2011_Data_Converter.pdf) so
that you understand and accept the limitations of the Data Converter.

Reckon Tools HUBB Investor*

Reckon Tools HUBB Investor is now available to you in
Quicken 2011 Personal Plus and Home & Business. It is a
powerful tool which combines technical and functional
analysis to help you analyse stocks for your long term
portfolio or short term trading opportunities. It includes
charting tools with a daily data feed from the ASX and NZX,
company health check and much more.

* Reckon Tools HUBB investor is a third party tool from HUBB Financial
Group, proudly brought to you by Reckon Limited.

You can choose to install HUBB Investor while you install
Quicken 2011. Alternatively, browse your CD and navigate
to d 2 \HAB\D I SK1\HUBB folder (where d: is your CD-ROM
drive) then run hubbinvestorsetup.exe to intall.

To run Reckon Tools HUBB Investor:

1. Choose Tools menu > Reckon Tools HUBB Investor.

BAS Report

The BAS Report has been enhanced by allowing you to
generate reports even if values for #4, 7D and 7C are not
applicable to your situation.

To run a BAS report:
1. Choose Reports menu > Business.

2. Click BAS Report.

Add a security

In Quicken 2011, the Cost Basis screen in the wizard for
adding a new security has been removed to speed up the
process.

To add a new security:

1. Choose Investing menu > Go to Investing Centre.



2. Click Today’s Data in the right-hand corner of the
screen.

3. Inthe Watch List snapshot, click Add a security.

4. Follow the on-screen instructions.

FIDO Calculators

The ASIC FIDO calculators, including Superannuation
calculator, Credit Card Calculator, First Home Saver Account
calculator and Managed Funds Calculator which were
available to you in previous releases of Quicken are no
longer available in Quicken 2011.

Tax line items and personal income
threshold

In Quicken Personal Plus and Home & Business releases
we include tax features which allow you to estimate your
taxable income for a particular fiancial year.

Tax line items have been updated for the 2010/11 financial

year to conform with the ATO Tax Pack released in July 2010.
Income tracking, tax related expenses as well as Income Tax
Summary report have been updated to reflect the changes.

Quicken has been updated with the new personal income
thresholds for the 2010/11 financial year. The personal
income thresholds are used to estimate the taxes payable at
the end of each financial year.

Quicken data file with No Categories

In Quicken 2011 when you create a new file, you will

now have the option to create the file with no default

list of categories. This is particularly useful if you or your
accountant wishes to set up a customised set of categories
for reporting purposes.

If you are creating a new file with no categories, be aware
that the tax lines (questions from the Tax Pack) will not
be available to you. Seek advise from your Accountant or
Accredited Advisor if you are selecting this option.



Express Setup interview

When you create a new Quicken file in the Express Setup
interview, you can now select whether your primary
chequing account is for business or personal use and also
set the tax tracking attribute for it.

This feature applies to Quicken 2011 Home and Business
only.

Quicken New Zealand - Tax Changes

Quicken New Zealand has been updated with the latest GST
rate of 15% as per the Budget 2010 changes.

For more information on how your business is affected,
please see the Inland Revenue website - http://www.ird.
govt.nz/

It is highly recommended that you read the Quicken 2010 Guide for NZ
October 2010 Tax changes document for more information (navigate

tod:\2010_11_NZQuicken_GSTChange.pdf whered:is your
CD-ROM drive).

Recent versions of Windows and User
Access Control
If you are using Quicken 2011 on Windows Vista or Windows

7 itis recommended that you leave the default setting for
User Access Control (UAC) during installation and use.

Reckon does not support Quicken in a non-UAC enabled
Windows Vista or Windows 7 configuration.

Upgrading a data file from Quicken 2004 or
earlier versions

If you are upgrading from Quicken 2004 or earlier versions
to Quicken 2011 and have passwords associated with your
data files, you should remove passwords from your data files
before upgrading.

Savings accounts created in Quicken 2004 or earlier versions
do not include an Account Location field. However, in
Quicken 2011 the Account Location field cannot be empty.
Thus, after upgrading from Quicken 2004 or earlier versions
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to Quicken 2011, savings accounts will display “Spending” in
the Account Location field.

The new In / Out / What's left feature allows users to
immediately see where their money is going using various
charts and tables. This feature displays information using
the savings accounts that show Spending in the Account
Location field.

If you are upgrading from Quicken 2004 or an earlier version
to Quicken 2011 and have savings accounts set up, you
should change the value in the Account Location field from
Spending to Saving. This ensures the In / Out / What's left
feature displays the correct information.

To change the value in the Account Location field:

1. Place the cursor over the account name in the at-a-
glance bar.

2. Right-click on the account name and select Edit
Account.

The Account details window opens.
3. Change the Account Location field from Spending to
Saving.
If you upgrade a data file that contains a
linked account

The Quicken 2011 Investment Activity Report reports on all
transactions from linked accounts. New transactions entered
in the linked accounts in Quicken 2011 will continue to
appear in the Investment Activity Report.

Upgrading from CashBook 2003 or
CashBook 2004

The Itemised Category Report in Quicken 2011 does not
include account balances forward by default.

To include account balances forward:

1. Open the Itemised Category Report.



2. Click Customise.
3. Click the Advanced tab.
4. Select Include All from the Transfers drop-down list.

If you have at any stage had ‘return of capital’ transactions
entered in an investment account that has a linked bank
account, the Itemised Category Report will not add the
return of capital transactions to the total.

Opening your original data file after
upgrading to Quicken 2011 from any earlier
version of Quicken or CashBook

When you upgrade to Quicken 2011, a backup copy of your
original data file is automatically placed in a folder called
OldFiles, which is located in the same folder as the data file
you are upgrading. Use this backup copy if you need to view
your original file in your previous version. You can choose
File menu > Restore or File menu > Open to open the file.

Opening Quicken 2009 and 2010 data files

Quicken 2009 and 2010 data files will not go through

the upgrade process and they should open without any
changes. However it is strongly recommended that you do
not attempt to open a Quicken 2011 file in Quicken 2009 or
2010 as it could lead to data corruption due to new features
not being available in the 2009 or 2010 release. You should
manually create a backup prior to opening a 2009 or 2010
file in Quicken 2011.

Deleting Categories

In Quicken, categories are labels that track how much you're
spending on particular types of items. If you try to delete

an existing category, make sure that no transactions have
been assigned to that category. This is to ensure that the
reports you run display figures correctly as there will be no
uncategorised income or expenses as a result of deleting a
category which has previously been used.
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Reckon Tools Backup Installation

To use the Quicken 2011 online backup feature, you will
need to install the Reckon Tools Backup Desktop application.

Insert the Quicken 2011 CD into the CD-ROM drive and
navigate to d 2 \HAB\D I SK1\Backup folder (where d: is
your CD-ROM drive) and run the setup.exe.

Other installation problems

If you experience any other problems during installation,
consider whether any of the following may be the source of
your problems:

« Are you logged onto your PC as the Administrator?
+ Have you shut down all applications?

« Is your anti-virus software blocking your installation of
Quicken?

If none of the above appear to be causing your problem,

try installing Quicken in Safe Mode. For instructions on
restarting your PC in Safe Mode, refer to your Windows Help.
After you have installed Quicken in Safe Mode, do not try to
open it immediately. First, restart your PC in normal mode
and make sure you are connected to the Internet. Open
Quicken and enter your Installation Key Code to Activate.

If you do not have an Internet connection, click Cancel to
close any activation messages and call Reckon Customer
Service to Activate over the telephone.

Still having problems? Check the Quicken online knowledge
browser at http://www.quicken.com.au/Support/FAQs.aspx
and search the database for “error message”.

Determine your upgrade path

Find your current Quicken version in the list below and
check the upgrade path. If there is a tick in the row for your
current version, then you can upgrade directly to Quicken
2011.



For example, if ‘CashBook v8'appears in the row for your

current version, then you must first upgrade your data file
to CashBook 2004. Follow the upgrade instructions on the
following pages carefully.

Your current
version

Home & Business 2010
Personal Plus 2010
Personal 2010

Home & Business 2009
Personal Plus 2009
Personal 2009

Home & Business 2008
Personal Plus 2008
Personal 2008

Home & Business 2007
Personal Plus 2007
Personal 2007

Home & Business
2005/2006

Personal Plus 2006
Personal 2006

Personal Plus 2005

Personal 2005
CashBook 2004*®
Personal Plus 2004°
Personal 2004®
CashBook 2003*®
Personal Plus SE 2002¢
Personal 2002°

CashBook v8+®

Personal Plus v8°

Personal v8°

Home &

Business Personal
2011 Plus 2011
v

v

v

v

v

v

v

v

v

v

v

v

v

v

v

v v

v v

v

v

v

v

v

v

CashBook

2004*

CashBook Personal
2004* Plus 2004*
CashBook Personal
2004* Plus 2004*

Personal
2011

V**

V**

Personal
Plus 2004*
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*Some CashBook features do not exist in Home & Business
2011.

*CashBook 2004 and Personal Plus 2004 Trials are provided
on your Quicken 2011 CD. Refer to the information below for
trial locations on the Quicken CD.

**f you have an investment account, you cannot upgrade
directly to Personal 2011, you must purchase Personal Plus
2011 or Home & Business 2011.

eIf you are upgrading a file to Quicken 2011 directly from
Quicken 2004 (or earlier) and receive the following data
conversion error:

Unable to load DLL: C:\Program Files\Quicken\convert03\qd3.dll
Required dlls for converting your data file is missing

Then you will need to upgrade your file through an
intermediate version of Quicken (either Home & Business
2005/06 or Personal Plus 2006 or Personal 2006).

Note:

« If you upgrading from CashBook V8, CashBook 2002,
CashBook 2003 or CashBook 2004 then you will need
to upgrade to the Home & Business 2005/06 trial before
upgrading to Home & Business 2011

+ If you upgrading from Personal Plus V8, Personal Plus
2002 or Personal Plus 2004 then you need to upgrade
to the Personal Plus 2006 trial before upgrading to
Personal Plus 2011.

« If your upgrading from Personal V8 or Personal 2002
or Personal 2004 then you will need to upgrade to the
Personal 2006 trial before upgrading to Personal 2011.

Upgrade Software Located on CD IKC
CashBook 2004 \\CV\CBTrial\
Personal Plus 2004 \\CV\2006Trial\
CV\PPTrial\Disc1
Home and Business 2005/06 ~ \\CV\HBTrial\ KNZY62XJL6HR
Personal Plus 2006 \\CV\2006Trial\ GCTZTRBXQJ3B




Upgrade Software Located on CD IKC
Personal 2006 \\CV\2006Trial\ GAY69KLCSJCK

Internet connection is required to use the Quicken trials
(Home & Business 2005/06, Personal Plus 2006 & Personal
2006) due to an activation process.

If you need to upgrade through one of the Quicken trials
(Home & Business 2005/06, Personal Plus 2006 or Personal
2006) but don’t have internet access then you will need to
contact Quicken support to get assistance with upgrading
your file.

Note: This doesn't apply to the CashBook 2004 or Personal
Plus 2004 trial versions.

17



Prepare your company data file for
upgrade

We strongly recommend that you follow the steps below to
protect your company data and ensure its accuracy.

1.

Back up your data file
1. In Quicken, open the data file you want to back up.
2. Choose File menu > Backup.

3. Inthe Select the disk drive and path to backup
folder field, identify the drive that contains the
backup media.

4. Click OK to start the backup.

For more information on how to back up, please refer
to the User Guide (available on the Quicken CD) or in-
product Help for “Backing up your data”.

Validate your data file

Ensure the data file you are using is validated before
upgrading your software. Validating a data file allows
Quicken to verify its integrity. Choose File menu > File
Operations > Validate. Find the data file you want

to validate and click OK. You will need to repeat this
process for every data file you want to upgrade.

Remove any passwords associated with your data file.

To remove your password from your data file, choose
File menu > Passwords > File or Transaction.

Print a selection of Reports from the data file in your
currently installed version

Print a record of all business Tax reports for previous
periods (e.g. Tax Detail, BAS). You can use these Reports
after upgrading to confirm the data which appears in
the upgraded version is correct.

Note: Some reports in Quicken 2011 have different
default settings to previous Quicken versions. In some



10.

11.

12.

13.

14.

cases, these reports may require you to customise the
report to obtain the same figures.

Ensure ALL unapplied Adjustments/Credits are applied
to an Invoice or deleted.

Delete all Scheduled Invoices and Payments (taking
note of details).

Take note of your Quicken Settings / Preferences

Some of the settings within your company file revert to
the default settings of Quicken 2011. Make a note of
your personal settings and preferences so you can apply
these to your upgraded data file.

Saved Reports may not be available after the conversion

We recommend that you print any Saved Reports from
your current version beforehand, for your reference.

ABN and Branch number may need to be re-entered in
your data file after conversion

If you have customised templates

Customised Invoice and Estimate templates from your
previous version only convert directly to Quicken
Home & Business if you install Home & Business in the
same installation directory as your previous version

of Quicken, once the previous version has been
uninstalled.

If you have a linked investment account

If you upgrade a Quicken company file that contains
a linked investment account, the Investment Activity
Report in Quicken 2011 will always report on all
transactions from both accounts. To avoid this, you
should un-link the accounts in your previous version
prior to upgrading.
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Upgrading your Quicken software

Reminder: before upgrading, have you:

«  Printed a selection of reports from your original Quicken
program.

+  Created a backup of your original company file and
validated it.

To upgrade from Quicken Personal v8 or Personal Plus v8 or
CashBook v8, start on this page.

To upgrade from a different version, start on page 22.

Upgrading from Quicken Personal v8 or Personal
Plus v8 or CashBook v8

In order to convert your data file to Quicken 2011, you
need to step your data file up through CashBook 2004. The
CashBook 2004 trial is available on the Quicken 2011 CD.

Install CashBook 2004 Trial

1. Make sure that your current version of Quicken
(Personal v8 or Personal Plus v8 or CashBook v8) data file
is backed up on disk then close Quicken.

2. Insert your Quicken 2011 CD into your CD-ROM drive.
The installation screen automatically appears. If this
does not happen, click the Start button and choose
Run, then type d:\autorun.exe (where d is your CD-
ROM drive) and click OK.

3. Browse CD.Then Browse to CV folder and then to
CBTrial folder, then run CashBook2004Trial.exe

4. Click Yes when prompted to install CashBook 2004.
5. Click Next when the Welcome screen appears.

6. Select where you would like to install CashBook 2004
and click Next.

Note: You should install CashBook 2004 in the same
installation directory as your previous version (default
location is C:\Program Files\quickenw).



10.

11.

12.

13.

Click Yes to uninstall your previous version of Quicken.
This will not affect your existing Quicken data.

Follow the prompts to uninstall your previous version of
Quicken.

Note: Click No to All when prompted to remove all
shared files.

When the uninstall process is complete, click OK.

Install CashBook 2004 (Browse CD to CV folder and then
to CBTrial folder, then run CashBook2004Trial.exe).

Restart your computer to complete the installation of
CashBook 2004.

Launch CashBook 2004 and upgrade your company file.
If you have more than one company file, each must be
upgraded by choosing File menu > Open and selecting
the company file.

Once you have completed upgrading your file(s) to
CashBook 2004, follow the instructions on page 22 -
Upgrading from Quicken Personal 2002, Personal Plus
2002, CashBook 2003, Personal 2004, Personal Plus
2004, CashBook 2004, Personal 2005, Personal Plus
2005, Home & Business 2005/06, Personal 2006, Personal
Plus 2006, Personal 2007, Personal Plus 2007, Home &
Business 2007, Personal 2008, Personal Plus 2008, Home
& Business 2008, Personal 2009, Personal Plus 2009,
Home & Business 2009, Personal 2010, Personal Plus
2010, Home & Business 2010.

Note: If you encounter the message “The file contains one or
more accounts that require access to features not currently
activated in this copy of Quicken’, you will need to read
Knowledge Browser article Q10227.

To access the Knowledge Browser, visit the Reckon website
at: http://www.quicken.com.au/Support/FAQs.aspx. In the
Knowledge Browser application, enter Q10227 in the FAQ
ID# field to read about this issue.
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Upgrading from Quicken Personal 2002, Personal
Plus 2002, CashBook 2003, Personal 2004, Personal
Plus 2004, CashBook 2004, Personal 2005, Personal
Plus 2005, Home & Business 2005/06, Personal
2006, Personal Plus 2006, Personal 2007, Personal
Plus 2007, Home & Business 2007, Personal 2008,
Personal Plus 2008, Home & Business 2008, Personal
2009, Personal Plus 2009, Home & Business 2009,
Personal 2010, Personal Plus 2010, Home & Business
2010

You may directly upgrade your data file to Quicken 2011.

Note: When you upgrade to Quicken 2011, a backup of your
original file is automatically placed in a folder called Oldfiles
in your Quicken directory.

Follow the instructions below to upgrade your data file to
Quicken 2011.

1. Ensure you have completed the instructions in section
“Prepare your data file for upgrade” on page 18. Make
sure you uninstall your current version of Quicken
before continuing.

2. Insert the Quicken 2011 CD into the CD-ROM drive. The
installation screen automatically appears. If this does
not happen, click the Start button and choose Run,
then type d:\autorun.exe (where d is your CD-ROM
drive) and click OK.

3. Select your region.
4. Click Begin.
5. Follow the onscreen instructions.

Note: You may receive a message requesting that

you exit and uninstall your previous Quicken version
before installing Quicken 2011. When you uninstall
your previous Quicken version you may be asked to
remove shared files? Select Yes to all. Reckon strongly
recommends you uninstall your previous Quicken
version before you install Quicken 2011.



You may be requested to restart your PC to complete
the installation. Select Yes to restart your computer, and
click Finish.

The first time you open Quicken 2011, you will

be required to Activate by entering your Quicken
Installation Key Code (IKC). The activation process will
take place automatically over the Internet. If you do
not have an Internet connection, click Cancel on the
messages that appear and call Customer Service to
complete the process over the telephone.

The first time you open your company file in Quicken
2011, the upgrade process begins. Read the upgrade
message and click OK if your want to continue. If you
have a large data file, or if you have investment data, the
upgrade may take several minutes.

Note: If you are upgrading from Quicken 2009 or
2010, your Quicken company files will not go through
the upgrade process and they should open without
changes.

Follow the prompts to set up your company file in
Quicken 2011. Click Done when you have finished.

After you upgrade

Check your data in the upgraded version. Run the same
reports you ran before upgrading and compare them to
confirm that the data matches. If your data does not match
the previous version, try to identify where the problem

is. For example, it may relate specifically to categories or
transactions.

Check the Quicken settings and preferences against the
settings you noted before upgrading your company file.

Explore Quicken’s many new features in What's new in
Quicken under the Help menu.

Back up your data file.

DO NOT OVERWRITE YOUR PREVIOUS BACKUP!

23



24

You may choose to back up your company file to a CD-
ROM or other storage media. Make sure that you label each
disk correctly and store it in a safe place in case you need
them later. Do not overwrite this backup. (You can find
instructions for backing up your data in the user guide,
which is available on the Quicken 2011 CD-ROM.)



New Quicken users
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Prepare to install Quicken 2011

Before you install Quicken, you need to:

Log on to your PC as the Administrator or have
Administrator rights.

Close any programs running on your PC.
Disconnect from the Internet.
Disable your anti-virus and firewall applications.

After you have installed Quicken, be sure to re-enable your
anti-virus and firewall applications. Then, reconnect to the
Internet so that you can activate your Quicken product
online.

Install Quicken 2011

To install Quicken:

1.

Insert the Quicken 2011 CD into the CD-ROM drive.

If the installation window does not open automatically,
click the Start button in the Windows taskbar and
choose Run, then type d:\autorun.exe, where d is
your CD-ROM drive, and then click OK.

Select your region.
Click Begin.
Follow the onscreen instructions to install Quicken.

Note: You will find your Installation Key Code (IKC) on
your CD case or in the letter you received with your
CD-ROM.

You may be requested to reboot your PC to complete
the Quicken installation. Select Yes.

Double-click the Quicken icon on your desktop to open
Quicken 2011.

Start a new file, or browse the features of Quicken 2011
using the sample file.



Activate Quicken

After you have installed and opened your software, you are
prompted to activate Quicken 2011.

You will find your Installation Key Code (IKC) on your CD case
or in the letter you received with your CD-ROM. You need an
Internet connection to activate online.

If you can't activate your product over the Internet, call 1300
650 061 (Australian customers only).
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Quicken 2011
End User Licence
Agreement
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Quicken 2011
End User Licence Agreement

THIS IS AN IMPORTANT DOCUMENT. PLEASE READ IT
CAREFULLY.

This is a contract between Reckon Limited (ACN 003 348 730)
(Reckon) and you. By using the Quicken software supplied with
this document, and the related user guides and materials (together
the Software), you agree to be bound by the terms of this Licence.
This Licence covers copies of the Software provided for evaluation
or trial purposes, subscription versions and non-subscription or
full versions of the Software. Some Licence provisions may not

be applicable to you, depending on the particular version of the
Software you have purchased or if you are using the Software

for evaluation purposes. The defined terms and the rules of
interpretation in this Licence are set out in clause 12.

Important: There are a number of technical features within
the Software that may affect your ability to continue to use the
Software. These are outlined in more detail in the terms of the
Licence, but in summary:

+ you are purchasing the right to use the Software, not to own it;

« if you have been provided with a Trial Version, you may only use
the Software on a temporary basis to evaluate the Software’s
functionality and suitability for your requirements;

+ the Software contains registration and activation processes to
guard against illegal copying;

+ to continue using the Software, those processes require you
to verify your compliance with the terms under which you
are licensed to use the software (for example: the number of
computers on which the software is installed) and to permit
continued reactivation of the Software from time to time. This
involves, in all versions, periodically verifying your licence details,
and in the subscription version, renewing your subscription
when it falls due. Reckon may also verify subscription customers
during a subscription period and not only at renewal. You will
also need to reactivate your Software if you want to reinstall it
(for example, if you upgrade your computer or if you have a hard
drive failure, and you may incur a technical support cost for this);

» when you purchase the Software or during the course of your
subscription you will be provided with an installation key code.
Please keep the installation key code in a safe place. You may
need it when you first install or re-install



(if permitted) the Software and to reactivate the Software.
Please note if you lose your installation key code that it will not
be replaced by Reckon and you will not be able to install or
reactivate the Software;

you also need a licence key to reactivate your Software. In
addition, with some older versions of the Software, you will not
be able to re-install or reactivate the Software if you do not have
your installation key code - see details below on Reckon'’s sunset
policy;

there will be no charge to activate the Software initially or to
reactivate your Software when you verify your licence details or
renew a subscription. Reckon may charge you a fee for technical
support if it needs to reissue a licence key provided also that the
version of the Software you are using has not been ‘sunsetted’
as explained below. Reckon may also charge a fee if you need to
reactivate the Software in other circumstances (for example, if
you need to reinstall the Software if you upgrade your computer
or due to a hard drive failure);

if you do not verify your licence details or renew your
subscription (as applicable) within the required period,

the Software may continue to operate but with impaired
functionality or you may not be able to access the Software at all
(including printing out or viewing any of your data or records);
and

Reckon has a‘sunset policy’ which means that technical support
is not available for some older versions of the Software. This
includes the ability to install or re-install that Software for any
reason if you have lost your installation key code for those old
versions. If you wish to continue using the Software in those
circumstances, you will need to purchase a new copy of the
current version of that Software.

. LICENCE

(a) Evaluation licence: If Reckon has provided a Trial Version of
the Software to you, your rights to use the Trial Version are
solely as set out in clause 10.

(b) Licence to use: Reckon grants you a personal, non-exclusive,
non-transferable, limited licence to use the Software on
the terms of this Licence for the period determined in
accordance with clause 8.

(c) No transfer of copyright: The Software is licensed not sold,
despite any reference to “purchase” or “sale”in this Licence
or in any invoice or purchase order for the supply of the
Software. Reckon reserves all rights not expressly granted
to you. Reckon Limited is the owner of copyright in the
Software and retains ownership of the copyright and all
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other intellectual property rights in the Software and is
protected by copyright law and international copyright
treaty.

2.YOUR PERMITTED USE OF THE SOFTWARE

(a)

(b

=

(c)

Single use licence: If you have purchased a single user licence,
you:

(i) may install the Software once, on one computer
only. However, if you wish to reinstall the Software
(for example, if you need to install the Software on a
replacement computer), then clause 3 will apply; and

(i) must ensure that the Software is used by one person
only at any one time.

Additional licences: Subject to any multi-user licence that you
have obtained, if:

(i) more than one person is to use the Software at the same
time; or

(ii) the Software is to be installed on more than one
computer

then you must obtain an additional licence for each
additional person or computer.

Premier Version

If you have purchased a full version of QuickBooks Premier,
this Licence entitles you to load the Software on up to three
computers (for use by a single processing unit only on each
computer) for use by up to three individuals simultaneously.
If you wish to install the Software on more than three
computers you must purchase additional licenses that will
permit up to five users to simultaneously access a data file.
If Reckon releases the next release of QuickBooks Premier
while you are a member of the Advantage programme
subject to its terms and conditions, you will be permitted to
make a total of five installations.

If you have purchased a subscription version of QuickBooks
Premier, this licence entitles you to load the Software on

up to five computers (for use by a single processing unit
only on each computer) for use by up to five individuals
simultaneously. If you wish to install the Software on

more than five computers you must purchase another

full version or a subscription version of that software but
for simultaneous access you will need to upgrade to an
appropriate version that permits more than five users to
simultaneously access a data file.



(d)

(e)

(f)

(9)

Accountant Edition

If you are an eligible Professional Partner who has purchased
a full version of QuickBooks Accountant Edition, this Licence
entitles you to load the Software on up to five computers
(for use by a single processing unit only on each computer)
for use by up to five individuals simultaneously. In some
special cases with written approval of Reckon only, certain
Professional Partners may be allowed to load the Software
on up to 25 computers. However, only 5 simultaneous users
can have access to any single data file

Enterprise Version

(i) Ifyou have purchased the QuickBooks Enterprise version
of the Software, this Licence entitles you to load the
Software on up to ten computers with the option to load
up to another 20 computers at the applicable charge (for
use by a single processing unit only on each computer)
for use by up to ten or more individuals up to a
maximum of 30 (as permitted by the Licence purchased)
simultaneously. You may not load the Software onto any
further computers.

(ii) If you have purchased the QuickBooks Enterprise
Accountants version of the Software, this Licence
entitles you to load the Software onto one computer (for
use by a single processing unit). You may not load the
Software onto any further computers.

General restrictions: You must not:

(i) use orrely upon the Software for any purpose or in any
manner for which the Software is not warranted;

(i) copy, reproduce, translate, adapt, vary, merge or modify
or create any derivative work based on the Software;

(iii

reverse engineer, decompile, disassemble, reconfigure
or otherwise attempt to discover the source code of the
Software; or

sell, market, network, transfer, lease, license, sub-
license, rent, lend or otherwise dispose of or distribute
the Software or use the Software to provide a bureau
service.

(iv

Licence verification: Upon written request from Reckon,
including by e-mail, you agree to provide Reckon with a
signed certificate:

(i) verifying that the Software is being used fully in
accordance with this Licence, including user and
machine limitations; and
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(ii) listing locations, types and serial numbers of equipment
on which the Software is run.

You agree to allow Reckon to use and disclose any personal
details provided to Reckon in connection with this Licence
in accordance with Reckon’s then current privacy policy
displayed on Reckon’s website.

(h) Audit rights: Reckon may also audit the number of copies of
the Software in use or possession by you, the equipment on
which the Software is installed or used and the number of
users using the Software. Audits will be conducted in your
normal business hours, or upon reasonable prior written
notice, at Reckon’s expense. If the audit reveals underpaid
or unpaid fees due to Reckon, you will be invoiced for them
based on Reckon'’s then current price list, and if these exceed
5% of the license fees you have already paid, you will also be
invoiced for the cost of the audit.

3. PRODUCT ACTIVATION AND VERIFICATION

(a) Initial registration and verifying licence details: This Software
may contain technology that protects Reckon against illegal
copying. As a consequence, you may be required to:

(i) register your details during the initial installation
(including your name, contact details and details of the
hardware on which the Software will be installed (if this
is not done automatically by the Software);

(i) if you have a full version, have the Software reactivated
periodically thereafter by verifying your licence details to
confirm you are using the Software in accordance with
these Licence terms;

(iii) if you have a subscription version, have the Software
reactivated (on payment of Reckon’s renewal fee and
verification of your licence details) if you wish to renew
the subscription;

(iv) have the Software reactivated by Reckon if you wish to
re-install the Software (for example, if you would like to
install the Software on a new computer or if you have a
hard drive failure and need to reload your Software); and

(v) provide to Reckon the details of your installation key
code and product key code for the Software as part of
the reactivation process.

You agree to activate or reactivate the Software within a
reasonable time or within such time as the Software prompts
you to do so.



(b)

(c)

(d)

(e)

(f)

(9)

Key codes: Each copy of the Software is provided with a
unique installation key code (which may appear on the
packaging or the cover of the media on which the Software
is contained). You should keep the installation key code safe.
As per clause 3(a)(v), you will be required to provide your
installation key code to Reckon when you reactivate your
Software.

Manner of verification: You must verify your licence details

in the manner required by Reckon from time to time (which
may include email or on-line registration via the Internet).
The Software may prompt you as to the required manner of
verification.

Charges for reactivation: Reckon will not charge you to
activate the Software initially or to reactivate your Software
when you verify your licence details or renew a subscription,
unless you have lost your installation or licence key code. You
need both your installation code and your licence key to be
able to reactivate the Software. Reckon may charge you a fee
for technical support to reissue a licence key code. Reckon
may also charge a fee for technical support if you need to
reactivate the Software in other circumstances (for example,
if you need to reinstall the Software because you have a new
computer or need to reload the Software due to a hard drive
failure). For the current fees go to http://www.quicken.com.
au. If you have lost your installation key code, Reckon will not
replace that code, and you may be required to purchase new
Software.

Consequences of non-renewal and failure to verify details:

This Software is provided to you on the understanding and
acknowledgment that it may contain technology which
deactivates and disables the Software if a subscription is not
renewed or in the case of a full licence version, you have not
verified your licence details when periodically prompted to
do so by Reckon or by the Software. If the Software is not
reactivated within the required period, the Software may
continue to operate but with impaired functionality or you
may not be able to access the Software at all (including
printing out or viewing any of your data or records).

Statutory declaration: In certain circumstances, before
permitting a re-activation, Reckon may require you to
provide it with a Statutory Declaration stating the reasons for
re-activation in a form required by Reckon.

Older versions: Reckon has a sunset policy (covered in more
detail in clause 4(a)) which means that technical support

is not available for certain older versions of the Software. If
technical support is not available for your version, you will
not be able to reactivate or reinstall your Software if you
do not have your installation key code. Reckon will not be
obliged to provide you with a replacement key code and in
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those circumstances you will need to purchase a new version
or Upgrade in order to continue using the Software. Please
go to http://www.quicken.com.au to see the sunset policy.

4. TECHNICAL SUPPORT

(a) Period when technical support is available: Reckon will
provide technical support for the Software only (and for the
avoidance of doubt this does not include support for third
party hardware or software, which remains the responsibility
of the relevant third party), during the following periods:

(i) inthe case of a subscription version of the Software,
during the period for which you have paid the relevant
subscription fees (unless further releases of the Software
in question are discontinued); and

(ii) in the case of a full version of the Software, there is a
‘sunset period’ during which technical support may not
be available for that version. The sunset period for a
version will commence on the earlier of:

(A) 2 years after the date on which you first installed the
version on your computer; or

(B) the date Reckon releases the second successive
Upgrade to that version.

For further explanation of Reckon’s sunset policy please
go to http://www.quicken.com.au.

(b) What is included as part of technical support: Reckon will
provide technical support in accordance with its then current
technical support policy, which may include:

(i) as contemplated by clause 3, the technical support
required to reactivate the Software or to issue a
replacement registration key code (for example, when
you verify your licence details, renew a subscription or if
you need to reinstall the Software);

(i) provision of telephone help desk support services;
(iii) access to technical information about the software
contained on Reckon’s website; and
(iv) the ability for you to download Updates,
but it does not include provision of Upgrades of the

Software. For further explanation of Reckon'’s technical
support policy please go to http://www.quicken.com.au.

(c) Fees: Clause 3(d) sets out the circumstances when you will
(and when you will not) be required to pay charges for the
technical support to reactivate your Software (including
when you wish to reinstall the Software) or for Reckon to
issue a replacement registration key code.

For all other technical support, Reckon may charge you a fee in
accordance with its then current technical support policy.
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5. ONLINE SERVICES

(a) Interaction with Online Services: The Software may contain
access to, or features that interface with, online services
(“Online Services"). Examples of Online Services that may
be applicable to the Software are EFTPOS, an online share
price download facility, a statement download facility, bill
and other payment services, a superannuation choice facility,
online backup facility, payroll services and a debt recovery
facility which are provided at an additional charge on a
subscription basis measured for one year from the date of
registration.

(b) Terms for Online Services: Certain Online Services are not
available for all versions of the Software. For example,
in the case of bank statement download services, not
all banks provide services that connect to the Software.
Online Services are only available for 12-month periods for
subscription versions and 24-month periods for full versions.
In the case of a full version, access to Online Services in the
second 12-month period may be subject to payment of
the applicable charges. In order to renew access to Online
Services at the end of the 24-month period in the case
of a full version, you will be required to have purchased
or upgraded to the latest version of the Software. In the
case of a subscription version, you must have renewed
your subscription. Internet access is required for all Online
Services. Charges may apply for the use of Online Services
(in addition to the cost of Internet access levied by your
ISP). Where Online Services are available, separate terms
and conditions with the provider of the Online Services
may apply. In some cases Reckon may be the provider. You
should check with the relevant third party provider as to
the terms and conditions of use. Access to Online Services
may be withdrawn by Reckon at any time. Reckon will not
be liable for the withdrawal of access to any Online Services.
Where access is to be withdrawn, Reckon may choose to
notify you in advance provided that you have supplied
Reckon with a valid and up to date email address.

(c) Otherthird party services and applications: In some cases you
may download other third party applications, for example
Google Desktop supplied by Google Inc. In such cases your
agreement to be bound by the terms of this Licence will also
bind you to the terms of use or other similar agreements
required by such third parties for use of their products.

6. LIMITED WARRANTY

(a) Software provided on an ‘as is’ basis: Subject to clause 7(b),
Reckon provides the Software to you on an “as is” basis
and without any representations by Reckon or any of its
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(b)

(c)

(d)

authorised distributors regarding the use, performance, or
results of the use of the Software.

Defects in media: Reckon warrants that the media on which
the Software is recorded is free from defects in manufacture
for a period of 90 days from the date of delivery. During this
period, if you return the Software to your place of purchase,
Reckon will replace any defective media on which the
Software was supplied and any Software on that media, free
of charge, unless you caused damage to the media due to
poor handling.

No guarantee that Software will be error free or that its use

will be uninterrupted: While Reckon has endeavoured to
make sure that the Software works substantially as per

the specifications published by Reckon from time to time,
Reckon does not guarantee that the Software will work on all
computer hardware platforms or configurations and makes
no warranty that the Software will be error free, that its use
will be uninterrupted or that it will be fit for your purpose.

Internet access, telecommunications networks, firewalls and
security: Reckon does not guarantee connections to its
online activation server as these may be dependent upon
third party networks and security measures over which
Reckon has no control.

7. LIABILITY

(a)

(b)

(c)

Certain rights cannot be excluded: The Trade Practices Act,
1974, and other laws may imply certain conditions and
warranties into this Licence and give you certain rights and
remedies that cannot be excluded or modified. This clause
7, and the limited warranties provided in clause 6, do not
exclude or modify any of those rights if to do so would
contravene that law or make any part of this Licence void.

Exclusion of warranties: To the full extent permitted by law,
Reckon excludes all conditions, warranties and rights that
may be implied into this Licence. If conditions, warranties
or other rights for your benefit are implied in this Licence or
otherwise conferred by law and it is not lawful to exclude,
restrict or modify them, then those conditions, warranties
and other rights will (but only to the extent required by law)
apply to this Licence.

Limitation of implied terms: Reckon’s (and its distributors’)
liability for breach of any implied conditions or warranties
that cannot be excluded is limited, to the extent permitted
by law and at the option of Reckon, to replacing or re-
supplying the goods or services or their equivalent again or
the payment of the cost of having the goods or services or
their equivalent replaced or supplied again.



(d) General exclusion and limitation: Other than as set out in
clauses 7(b) and 7(c), and to the full extent permitted by law:

(i) Reckon (and its authorised distributors) will not be liable
to you or any other person for any direct or indirect
loss, damages, liability, costs or expenses suffered by
you or any other person relating to the performance or
non-performance of the Software or any breach of this
Licence or the supply of the Software or in connection
with, but not limited to, the Online Services, use of tax
tables, use of third party hardware (for example but
not limited to Postec services) or provision of technical
support (whether by telephone or remote access or
other means); and

(i) Reckon’s maximum liability for damages arising in
connection with this Licence or the supply of the
Software is limited to the amount paid by you for the
Software.

(e) Your liability to Reckon: You agree that Reckon (and its
authorised distributors) will not be liable, other than as
expressly set out in this Licence, and that you will indemnify
Reckon (and its authorised distributors) from any liability,
loss, damage, costs or expenses which you may suffer or
incur as a result of your use of the Software (including any
claims made against you by third parties).

(f) Use of Software is not provision of professional advice: The
information contained in this Software may include features
designed to assist you in complying with the requirements
of the relevant legislation; e.g., superannuation. If the
Software contains features to assist with superannuation,
e.g., superannuation guarantee requirements, then Reckon
does not warrant that the relevant reports will be compliant
with legal requirements, as these change from time to time.
You agree it is your obligation to ensure that deductions
and rates used for deductions for superannuation, taxation
(of any nature) and any other deductions/contributions
calculated using the software are correct from time to time
and at the applicable time and that nothing in the software
constitutes professional advice in relation to these matters.
The help contained in this Software is not a substitute for
professional advice. Legal and accounting advice should
be obtained before taking any action in reliance on this
Software. The software is also not financial product advice.
In addition any tax tables (which are included with certain
versions of the Software, e.g., QuickBooks and Payroll
Premier) that might be supplied with this Software are also
changed from time to time and you should consult with
your professional adviser before relying on the tax tables.
Reckon does not warrant that the tax tables are up to date at
your date of purchase. In providing you with the tax tables,

39



40

(9)

(h)

(i)

(a)

Reckon is not engaged in rendering legal, accounting or
other professional services. If legal advice or other expert
assistance is required, you should seek the service of a
competent professional.

Reckon has no responsibility for ecommendations: Reckon, its
employees, agents, contractors and the authors disclaim any
and all liability and responsibility to any person, whether a
user of this Software or not, in respect of anything (including,
without limitation, any error in or omission from this
Software) and of the consequences of any actions taken or
omitted to be taken in reliance, whether wholly or partially,
upon all or any part of the content, recommendations or
help contained in this Software.

Corruption of data and on-line access: To the full extent
permitted by law, Reckon and its authorised distributors
disclaim all liability for any corruption of data, inability to
access data, loss of data, breach of privacy, or downtime as
a result of or arising from the use of any online link available
between the Software and another server including without
limitation in connection with any Online Services.

On-line services: Reckon makes no warranty or representation
in connection with the Online Services, the responsibility

for which rests with the relevant provider of such Online
Services.

8. TERM AND TERMINATION OF LICENCE

Licence Term: Unless this Licence is terminated earlier in
accordance with its terms, your right to use the Software in
accordance with this Licence continues:

(i) inthe case of a subscription version of the Software,
for an initial period of 12 months from the date
of registration of the Software. This Licence will
automatically renew for a further 12 month period upon
the payment of Reckon’s annual subscription fee. If
the annual subscription fee is not paid on or before the
termination of the current 12 month period, this Licence
will automatically terminate; and

(ii) in the full version of the Software, indefinitely, however:

(A) you may be required to periodically verify your
licence details and have the Software reactivated as
per clause 3 in order to keep using the Software; and

(B) if you need to reinstall the Software, you will need a
copy of your original CD (or other media on which
the Software was provided) and the installation
key code. If you do not have the CD, you will need
to purchase or upgrade to a new full version and
pay for the postage associated with sending the
CD to you. Clauses 3(d) and 3(g) outline when



(b)

(c)

(d)

Reckon may charge you a fee for the provision of
a replacement key code and, more importantly,
when a replacement key code will not be provided
by Reckon due to the operation of Reckon’s sunset
policy.
Termination by Reckon for breach: Reckon may terminate this
Licence if you are in breach of its terms or as otherwise set
out in this Licence.

Survival: Clauses 2, 4, 6, 7 and this clause 8 will survive the

termination of this Licence. Termination of this Licence will
not prejudice any right which Reckon may have, or but for
the termination may have had, against you for a breach of
this Licence.

Things you must do upon termination: Upon the termination
of this Licence, you or your representative must promptly
uninstall the Software from your computer, destroy the CD,
User Guide and related materials and any copies of them

in your possession or control or return or dispose of them

in the manner directed by Reckon. Upon written request
from Reckon you agree to provide a Statutory Declaration to
Reckon that you have complied with your obligations under
this clause 8(d).

9. SUBSCRIPTION TERMS

If you have purchased a subscription version of the Software, this
additional clause 9 will apply.

(a)

(b)

(c)

(d)

Entitlement to Upgrades and Updates: During the period

for which you have paid subscription fees you will receive,
included in the cost of the subscription, all Upgrades and/or
Updates of the Software, via Internet download.

No extension of Licence term: Your right and entitlement to
use the Software, as enhanced by any Upgrades and/or
Updates, concludes at the end of the term of the Licence
(subject to payment of an annual subscription fee) and is not
linked to the dates of release, registration or provision by
Reckon of any Upgrades and/or Updates.

This Licence prevails: If you have purchased this Software as
an Upgrade to an earlier version of the Software, this Licence
shall supersede any previous licence agreement.

Not all Upgrades included: Your subscription to the Software
and any Upgrades and/or Updates under this Licence does
not grant you the right to receive special versions of the
Software created for certain customers or market segments,
even though they may contain similar features or functions.
Versions of the Software which may from time to time be
offered in retail or other channels in different configurations
as special promotions are not included as part of the
subscription.
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(e)

(f)

(9)

(h)

(i)

(a)

No obligation on Reckon to upgrade: Upgrades and/or
Updates will be developed and released by Reckon in its sole
discretion, and Reckon does not warrant or represent that it
will develop or release any Upgrades and/or Updates during
the term of the subscription period or Licence. Furthermore,
Reckon does not warrant that the Upgrades and/or Updates
will be provided to you or made available within any
specified time period following the commercial release of
such Upgrades and/or Updates.

When payment is due: If applicable to the Software licensed
to you, you will be required to pay the monthly subscription
fee in advance on the first business day of each month. You
authorise Reckon to direct debit your monthly subscription
fee from the bank account nominated by you.

Deactivation at end of subscription period: As per clause 3, the
subscription version of the Software is provided to you on
the understanding and acknowledgment that it may contain
technology which deactivates and disables the software

if your subscription is not renewed or you are found to be

in breach of this license agreement If the Software is not
renewed by the end of the required period, the Software
may continue to operate but with impaired functionality or
you may not be able to access the Software at all (including
printing out or viewing any of your data or records).

You need a full version if you don’t renew: If you elect not to
renew your subscription, the Software does not allow you
to upgrade to a non-subscription version of the Software
by way of the purchase of an Upgrade pack. In such
circumstances, you are only able to upgrade to a later non-
subscription version of the Software by purchasing a full
(non-upgrade) version of the Software.

Early termination: If you wish to terminate your subscription
early, you must do so by giving Reckon no less than one
calendar month notice to that effect. Depending on the
type of software you have subscribed to and the type of
subscription you are signed up for, you may be required to
pay a cancellation fee. See http://www.quicken.com.au for a
schedule of fees. Reckon will direct debit your account, and
you agree to pay, the applicable cancellation fee.

10. TRIAL LICENCE

If you have been provided with a Trial Version of the Software, this
clause 10 sets out the terms that will apply to your use of the Trial
Version.

Licence: Your licence to use the Trial Version:

() permits you to evaluate the Software’s functionality and
suitability for your requirements;



(i) is for the number of users set out in the material
accompanying your copy of the Trial Version;

(iii) is subject to the general restrictions in clause 2(e) and
the limited warranty in clause 6(a);

(iv) is for three months (Evaluation Period); and

(v) in the case of Reckon Retail Point of Sale, does not
integrate with QuickBooks.

(b) Duration: You acknowledge that your licence to use the Trial
Version will only apply for the Evaluation Period. At the end
of the Evaluation Period:

(i) you must not and will not be able to continue to access
the Trial Version, including any data that you have
entered into the Trial Version; and

(i) if you wish to use the Software you must purchase a full
version or subscription version of the Software.

(c) Entitlements: You:

(i) arenotentitled to Upgrades or Updates (or any other
software other than the Trial Version); and

(i) may be required to pay for any technical support
that you may require in relation to the Trial Version in
accordance with Reckon’s then current charges.

(d) Liability: You acknowledge that subject to clauses 7(b) and
7(c), and to the full extent permitted by law, Reckon excludes
all liability to you for any loss, damage, liability, costs or
expenses suffered by you relating to the performance or
non-performance of the Trial Version or any breach of this
clause 10.

11. STUDENT EDITION

(a) If you are using a Student Edition, your Software may
have limited licence rights as well as limited functionality,
including:

(i) alimit on the number of transactions that can be
entered;

(i) alimit on the number of company files that can be
opened;

(iii) a limit on the number of QuickBooks features and
services available.

(b) Your Software may be deactivated at the end of three years
from the date of installation and this may prevent access
to the Software and data unless an appropriate upgrade is
purchased.

(c) There is no support available for the Student Edition.
Support requests must be directed to your educational
institution.
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(d)

Reckon does not warrant that any information in the
Software is up to date, for example functionality required
for certain lessons involving tax tables or payroll tax, and it
is your sole responsibility to check with your educational
institution whether any information is up to date.

12. GENERAL

(a)

(b)

(c)

(d)

(e)

(f)

(9)

Some defined terms: In this Licence:

Trial Version means Software that has been provided to

you on a temporary basis in order to carry out a trial of that
Software to determine whether you wish to use the Software
on an ongoing basis.

Student Version means Software that is licensed to you as
part of your educational institution’s arrangement with
Reckon or Software that you have purchased that Reckon
has determined is a Student Version.

Upgrade means a new version of the Software which
contains additional functionality or other enhancements.
Reckon will determine whether a new version constitutes an
Upgrade or an Update.

Update means a new version of the Software which contains
minor enhancements.

Applicable law: This Licence is governed by the laws of the
State of New South Wales, Australia.

Entire Agreement: This Licence contains the entire agreement
between Reckon and you in relation to its subject matter
and supersedes any prior agreements and understandings,
whether written or oral.

Waiver: Any failure to enforce any rights under this Licence
by Reckon is not to be taken as a waiver of those rights.

Variation: To the extent permitted by law, Reckon may

vary any of the terms and conditions of this Licence upon
providing you with thirty (30) days notice in writing and a
copy of the replacement terms and conditions. In the case
of subscription users no new terms will come into force
until the commencement of your renewed subscription
period. Reckon will display any new terms and conditions
on Reckon’s web site and you should check the QuickBooks
website regularly. See http://www.quicken.com.au.

Headings: Clause headings are for ease of reference only and
do not affect the meaning of this Licence.

Third Party Applications and Technology: in some versions

of the Software, you may in the installation process also
have installed third party applications and technology. The
terms of this Licence apply to your use of all such third party
applications and technology.



Quicken and QuickBooks are registered trademarks of Intuit Inc.
Software is © 2010-11, Reckon Limited.

All rights reserved.
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Product updates available online

Reckon regularly posts product news, announcements,
and other information of interest to Quicken users on our
website, http://www.quicken.com.au.

From the website, you can download product-related files,
such as software service packs and product updates. To
keep your software secure and up-to-date, visit the website
regularly.

You must be a current Advantage or Subscription customer,
using the latest version of the software in order to access
these files. This also applies to replacement updates if they
are lost, for example by a hardware failure. To avoid potential
problems, be sure to keep your Annual Membership up to
date.

Store your Quicken products safely

Your unique Licence Key and Quicken 2011 CD are extremely
valuable and may be required to reactivate or reinstall the
software. Please keep your Licence Key in a safe place with
your Quicken 2011 CD. If you lose your Licence Key or CD,
they will be replaced only while this version of the software
is supported, and administrative charges may apply.



Your important reference numbers

Customer ID:

Customer PIN:

Installation Key Code:

Installation | Computer/ | Product Key Licence Key
User
10035982- 36934289-
Example Reception 00858381- 33878219-
56326598 90236598
PC

You will need these numbers for re-registration purposes.
Please have these details on hand when contacting Reckon.

To find these details in Quicken, go to the Help menu and
click Licence Information.

My original CD is safely stored here:
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Contacting Reckon
Technical Support

Australia

For installation and software support, Technical Support
is available Monday to Friday, 9.00am - 5.00pm AEST.
Weekend support is also available, check website for
opening hours. Extended hours are available to Reckon
Advantage members.

e 1902 223 101 (Advantage members, please refer to your
Welcome Pack for Advantage technical support contact
details)

Call costs $4.90/min (incl GST) Charges are higher
from public and mobile phones. Call costs and
operating hours are subject to change.

www.quicken.com.au/support

New Zealand

Technical support is available Monday to Friday,
9.00am - 5.00pm NZ.

Q Per minute support 0900 33 609
Call cost - $4.95 /min (plus GST)
Charges are higher from public and mobile
phones. Call costs and operating hours are
subject to change.

www.quicken.co.nz

Asia

Technical support is available Monday to Friday, from
9.00am - 5.00pm at US$40 per incident support.

e Singapore +65 6254 2322

www.quicken-asia.com
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